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FMC PRECISIONPAC & PERIMETER Il INSTANT DISCOUNT PROCESS

Growers that purchase PrecisionPacs and Perimeter 11 as a combination on the same invoice may qualify
for an Instant Discount'.

Note: The manufacturer of all products involved must be FMC for the FMC Sales
Data Export to include the transactions.

What you'll find:

Y=Yl =T oI g T=I o oY [¥ ot £ PR 2
FIMC INSTaNt DISCOUNT.....oiiiiiiiiiiiiiiic ettt 2
=T 10 =T = | PP PP PP 3
PrecisionPacs (must be done for each PrecisionPac eligible for disount) ..........ccccceeieiieiiiiieeeenen. 4

Sales of PreciSionPac + PerimeEter Il ... ettt sttt st be e e s esnee e 6

RELUINS OF PEIIMELET Il ettt sttt sb e bt st sat e et eneennees 8
If the Purchase No Longer Qualifies for an Instant DiSCOUNT.......cceeeeiiiiiieeiiiee e 9

REPOITING 1O RDS ..ttt et ettt e e e e e e sttt et e e e e s s s bbbt e eeeessssssbabeeeeessessasnreneeeas 11

Help The FMC Instant Discount Process has been summarized as an FAQ with links
to the corresponding activities.
From Table of Contents: FAQs Frequently Asked Questions > Accounts
Receivable > Invoices
-or-
search for FMC

! Please refer to documentation provided by FMC for grower eligibility specifics.
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Setting up the Products

The items in play for the Instant Discount process are a new FMC Instant Discount product
(non-inventory), the PrecisionPacs, and the Perimeter II.

FMC Instant Discount

This is the non-inventory item added to the invoice that reduces the amount the grower is charged.
On the Products tab, make sure Inventory Item is not checked and the Manufacturer is FMC.

% Add Product

|HS ve | Refresh | i Prices/Taxes

Preduct Code:
Description:
Short Desc:
Product Type:
UPC Code:
Default Project:

L Units ] In\rentory] Maotes ] Associated F'roducts] Blendingl Manufactuﬁng] Dangerous Go

not checked as is
D B | non-inventory item

[o ] & s

This product is active.

[~ Inventory ttem?

[FMCDISC

]FMC Instart Discourt & [ Blendable?

] [~ Manufactured?
‘5DCPROT—HEF~!BICIDES (5075004) j' Add [ Dangerous Good?

] [~ Omit From Sales Reports?

| | Add

Manufacturer:

[FMCOFCANADALTD | AgCallect

Manut. Prod. Code: !

Regulations ]

¥ Retumable?

™ Prohibit Purchass?

™ Exclude from AgCollect?
™ Ovemidable Sales Account?

—GL Accounts — Product Characteristics
Sales: ‘45[}]}5 - Sales Chemicals jt Charactenistics
[iscounts
COGS: - -
! B > tional -
Inventory: ] J opboona
Inv. Accrual: ‘ |
Add GL Account Add
Inventory > Manage Products
Note: Manufacturer must be FMC and Inventory Item is NOT checked.
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The Main Unit is Acre and priced at the current discount/acre rate.
Refer to the documentation provided by FMC for the exact rate.

" Add Product B8 EoE
JHSave ‘ Hf,fresh ‘ % Prices/Taxes ‘Q Exdt ‘
Product In\rentoryl Motes | Associated Products | Blending | Manwufacturing | Dangerous Goods | Regulations |
Units Main Units? | Company P1 Price| Active?
= |AC- Acre (52.50)
: 0

Perimeter Il

On the Product tab ensure the Manufacturer is FMC.

> Edit Product: 3101011 - PERIMETER Il 3.4 L
JnSave ‘ Refresh ‘ 7 Delete | ‘ Prices/Taxes ‘g Exit ‘

Product |Unit5 I Inventory' Notes I Associated F'roduc:tsl Elendingl Manufactuﬁngl Dangerous Goods

This product is active.

Product Code:  [3101011 N ¥ Invertary It
Description: |PERIMETER 1134 L B I Blendable’
Short Desc: I [~ Manufactur
Product Type:  [S0CPROT-HEREICIDES (5075004) B Add I" Dangerous
UPC Code: | I™ Omit From &
Default Project: | ~] Add FCL Mapping
Item Mo
Manufacturer; IF MCOF CANADA LTD | AgCallect |
ltem Cateac
TanuT. Frod. Looe:
Note: Manufacturer must be FMC.

On the Units tab, add Unit = JU and Conversion Factor if applicable.

' Edit Product: 3101011 - PERIMETER Il 3.4 L [ (3]
JnSa\re | Refresh ‘ 7< Delete ‘ ‘ Prices/Taxes |$ Exit |

Product Units Iln\rerﬂoryl Motes I Associated F‘roductsl Blendingl Manufacturing | Dangerous Goodsl Hegulaﬁonsl

nits Main Units? | Conv. Factor to Main Company P1 Prioel Active? | Mapped?
EA - Each 1.00 §204.00

= [JU-Jug = = 1.00; £204 00 ]

- = E [E

There are 1 Jug per 1 Each. A Units |

Remowe Units |
NOTE: "Conv factor to main’ is expressed as the

number of units in 1 main unit of product
T T MM’WWMW Bk

sales of Perimeter must be reported to RDS in JUgs
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On the Notes tab add a popup reminder about the Instant Discount for Returns.

* Edit Product: 3101011 - PERIMETER I 34 L =N =N =
Jngave ‘ Eefresh ‘ xgeli ‘ s Prices,/Tanes |'@ Exit |

F‘rodudl Units I Invertory MNotes |Associated F‘roduc:tsl Elendingl Manufadun’ngl Dangerous Goodsl F{egulznionsl

Popup Motes Printed Motes
Invoice: RETURNS: Check sale invoice if EMC Instant PCP #25212
Discount applies
‘__F\M{_,lﬁ-t{[:_L_rl_ TI?EEI—-W‘_‘_“ ,nl_ A e e M;«-"M\lz e = P e I

if the grower returns the Perimeter, they may no longer
be eligible for an Instant Discount on the PrecisionPac

PrecisionPacs (must be done for each PrecisionPac eligible for discount)

On the Product tab ensure the Manufacturer is FMC.

% Edit Product: EXPRESSPRO - Express Pro Precision Pack (7.1g/ac)
JES# | Refresh | 7 Delste ‘ s’ Prices/Taxes |6 Exit |

Product |Un'rt5 I In\rerrtoryl Motes I Associated F‘roductsl Blendingl I'u'IanLrFactuﬁngl Dangerous Go

This product is active.

Product Code:  |EXPRESSPRO i V' Inverto
Description: IEIDI‘BSS Pro Precision Pack (7.1g/ac) iF [ Blendat
Short Desc: | [v Manufa
Product Type: |51]CF‘F{OT-HEF{BICIDES (5075004) Ll iF Add [ Danger
UPC Code: | [ Omit Fro
ult Project |
|_|:1:LfECtLI'5I'Z |F M COF CANADA LTD

Note: Manufacturer must be FMC.

On the Notes tab add a popup reminder about the Instant Discount.

.~ Edit Product: EXPRESSPRO - Express Pro Precision Pack (7.1g/ac) =n| ===
Jngave ‘Eefresh ‘xgel ‘ s’Pricestast |6E§1 |

Produdl Units I Inventony Netes |.Pussociated F‘roductsl Blendingl Maneraduﬁngl Dangerous Goodsl F{egulaﬁonsl

Popup Motes Printed Motes
Invoice: ] PERIMETER Il DISCOUNT MAY FCP #25212
APPLY™
icket: i PCP #25212
Ltoiirt L1t i T e e B et AU U
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Add the FMC Instant Discount item you just created to the Associated Products tab.

e

% Edit Product: EXPRESSPRO - Express Pro Precision Pack (7.1g/ac)

(=& ]=]

Jnﬁave |Eefresh ‘Xgelete “F‘l‘icesiames |6E:_ut ‘

F'roductl Units I Imrentnryl Motes ~ Associsted Products |Blending| Manufactunngl Dangerous Gondsl F{egulatinnsl

|Produc:1 % Add Asscciated Product Row
| © Updte | [P Refresn | Dt |

Product: IFMC Instant Discount - FMC Discount
Units: IN: - Acre ;I .
Quantity: I 1[5

Offer Azzociated Products

Type: ] Wwork, Order ¢ All Customers
[ Loadout Ticket
Add ™ rvoice  QOnly Customers with this Characteristic:
Blend I y
Field Scout

Add a second Associated Product for Perimeter 1. Units = Jug.

%7 Add Associated Product Row
JOUpdate |F{efre5h |6En't |

Product: |31D1£i11 -PERIMETER 11 3.4 L
Units: jU-dig — ~|°
Qluantity: I 1"

Offer Associated Products

[ Wwark Order = All Customers

7] Loadout Ticket
B ™ Only Customers with this Characteristic:

| =l

Inventony Receipt

Setup the rest of the PrecsionPacs the same way.
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Sales of PrecisionPac + Perimeter Il

When selling a PrecisionPac you’ll be reminded of the FMC Instant Discount.
Click OK to acknowledge.

-

& Add Invoice EI@
JnSa\re | Hefresh |Spl'rt | "\ﬁewCred'rt |\c"|ew Prepayment |\c"|ewWOﬁdi\r'rty |®Exrt |
Reference: I * ¥ Generate Reference Automatically LT St Albert LI -
Customer: |1112 Baker, Mike 1* o 1 1 in m
- § Add Invoice Purchase Row >
Invoice Date: [Nov 05,2018 ~| Due Date: | D¢ hd

Customer and Shipping  Purchases | Retums | Totals | immed| @ Updste | [2) Refresh | @ Bt |

[
IEXF‘RESSF‘RO - Express Pro Precision Pack (7.1g/ac) LI " Find | LOT Ref

| Product
when adding the JAC - Acre ="
PrecisionPac, the Popup [5t- Abet =
Note will remind you of the
Instant Discount Reminder %
Purchases Subtotal (be ity on pnove Fow |
Prepaid Purchases (before tax): £0.00 . e =
Quantity: 0 FFEMC PERIMETER || DISCOUNT MAY APPLY* 0 Frepayment |
Prepayment Remaining: 5$60.359.16 o -
Unit Price:
Line Total:

Line Commen

Accounts Receivable > Invoices > Purchases tab > Add > Add Product

Type the Quantity in Acres the customer is taking. On Update ...

-ﬁ’h Add Invoice Purchase Row >
JQ UpdatiZ) [2) Refresh ‘QExit ‘
I

Product: |EXPRESSPRO - Express Pro Precision Pack (7.1a/ac) ~]" Find |
Units: IﬂC - Acre b LI i

Location: ISt- Albert

enter Quantity
inacres

ails

T

Quantity on Hand:

Quantity:

Uit Price: | S780 ©  Prcing | T Prepay?
Line Tetal: | $1,170.00

A o

... you’ll be prompted to add the FMC Instant Discount and the Perimeter II. The Quantity of Perimeter
will need to be corrected - you’ll update that to the actual value next.

%7 Add Associated Products ) *
| you will update to the
J & Use Selected Hm_\"T'\ |69 bt ‘ correct quantity shortly
Eetertey | Quantiv® | Prod
el 150. DISC - FMC Instant Discount (AC)
150.0000 3101011 - PERIMETER 11 3.4 L (JU)

2 associated products selected Select All I Deselect All L
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All 3 items are added to the invoice.

The Instant Discount is calculated per acre of PrecisionPac.

sstomer and Shipping  Purchases (3) | Retums I Totals I Immediate Payment I

$204.00 |

3101011 - PERIMETER Il 3.4 L (JU)

150.0

Purchases Subtotal (before tax): §31,395.00

Product Quantity Unit Price Taxes Line Total | Prepay? | Location WO Ref LOT Ref
EXPRESSPRO - Express Pro Precision P) 150.0 £7.80 £0.00 §117000| [0 St. Albert
FMCDISC - FMC Instant Discount (AC) 150.0 (52.50) £0.00 (£375.00) [ St. Albert

$0.00| $3060000| [  |St Albert

Select and Edit the Perimeter Il product row.

AddProduct Row | Add Blend Row || Edit Row ) ll Remove Row

Refer to the documentation provided by FMC and calculate the Quantity to correspond with the desired

application rate.

é’; Edit Invoice Purchase - Row 3 *
| @ Uit | BlRefesn | Ext |
Product: [3101011 - PERIMETER 1l 3.4 L ~|" Find |
Units: J4U - Jug =&
Location: St. Albert
ocaton: | 1  updateto
Quantity grower
( is actually taking
Quantity on Hand: e eiailq_-
Quantity: | 150,
IUnit Price: I 20400 Fricing | V¥ Prepay?
Line Total: | $30,600.00
o e T - - v e e A A
Edit Row

Process the rest of the Invoice as per your usual business practice.
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Returns of Perimeter Il

When returning Perimeter Il you’ll be reminded that the grower may have received an Instant Discount and
you should check if that original purchase of PrecisionPac still qualifies for that discount.
Click OK to acknowledge.

-

& Add Invoice - . EI@
. & Add Invoice Return Row >
Jnga\re | Eefresh |Spl'rt_ | "\ﬁewCrgd'rt )
| @ Upiste | (A Refresh | @ Ext |
Reference: I © ¥ Gene . Ll i
z 3101011 - PERIMETER 11 3.4 L - i —_
Customer: |1112 Baker, Mike IRt I —l M
2010 = Units: -

Invoice Date: INDV 06, 2015 'l Duel I —l i $0.00
Location: St. Albert -

Customer and Shippingl Purchases Retums |Tota oeston I _l

| Product Reminder *
Quanti . ]
reminder to confirm
Quanti NET Quantity still
Unit P qualifies for Instant
. Discount
Returns Subtotal (before tax): &
| Line C
Prepaid Returns (before tax): 8|

Accounts Receivable > Invoices > Add > Returns tab > Add Product

First, confirm the grower has purchased this product from you.

&) Add Invoice Return Row x

| @ Wodste | B Refresh | @Bt |

Product [3101011- PERIMETER 1134 L ~1"_Find |

Units: [1U-Jug 44— retums are in JUgs too
Location: IST- Albert ™~

Quantity on Hand: -20 Details I

Quantity: I | @P
Unit Price: I £204.00 ricing I [~ Prepaymert Retum?
J—Lﬂﬁ.M’ e o AI} P e e ]

e e T A S e e A Vi e e PRy
|Tax |Charge| Amnunt| Prepay? |

—

( 1 } Last sold to this customer at this location: 8.0 @ $204.00 on Nov 06, 2019 (Charge Acct)
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Then click Pricing and View Item (in this case, it’s an Invoice).

% Pricing Info for PERIMETER 11 3.4 L

|0 Update | 5 Cost Details ‘@Calcmamr ‘(3 Exit ‘

Product: PERIMETER Il 3.4 L (per Jug)

Use This Price: S20400 Reset To Suggested Price |
Suggested Price: S204.00 &

Curment Prices ] Mo Sale Prices  Sales History (1) ]

Sales Date Guantity Unit Price | Prepaid | Blend

Location Paid By

= | Nov 05, 2019 3| s20400 [ &

St. Albert Charge Acct

M Total Quantity: 8

i

Refer to documentation provided by FMC to confirm the net quantity of Perimeter purchased (initial
purchase less amount returned) still qualifies the PrecisionPac for an Instant Discount.

If the PrecisionPac purchase no longer qualifies for the Instant Discount, take note of the Quantity
(number of acres) of the Precision Pac sold on the Invoice - you’ll need that value for the next step.

If the Purchase No Longer Qualifies for an Instant Discount

If the return of the Perimeter Il negates the combination Instant Discount on the PrecisionPac, it also must

be returned on the same invoice.

Add the FMC Instant Discount to the Returns tab of the Invoice.

FMC PrecisionPac & Perimeter Il Instant Discount Process

& Add Invoice
| = save | Refresh | Split §§ View Credit View Prepayment | View WO Activity | €9 Bxit |
. &) Add Invoice Return Row
Reference: [V Gener
Update | [2] Refresh | €3 Bt |
Customer: ]1112 Baker, Mike | © Update ech | Q)
Invoice Date: |Mov 06, 2019 - CDue D Product: ]FMCDISC - FMC Instant Discount j " Find
Customer and Shipping ] Purchases Retums (1) ] T{ Units: ]AC - Acre ﬂ '
Location: ]St- Albert =
| Product | o
> 3101011 - PERIMETER Il 34 L (JU) | Quantity = # of acres
of PrecisionPac of
original purchase
Quantity: ] 1500 ©
: 5612 -
IREErs ST et { Unit Price: (52.50) Pricing ™ Prepayment Retum?
. &
Prepaid Returns (before tax): s Line Total =m0
Prepayment Remaining: $60.35¢ _
Line Comments: |

(5612,

-

Remave
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There’ll be two rows on the invoice:

e Line 1 is the return of the Perimeter Il - a negative value that will be credited to the grower

e Line 2 is the return of the FMC Instant Discount - a positive value that is deducted from the amount
of the return of the Perimeter II.

Prepaid Returns (before tax): £0.00
Prepayment Remaining: 5$60.359.16

" Hidd Froduct How !

& Add Invoice (=N Ew >
| n Save | Refresh | Split §§ View Credit | View Prepayment | View WO Activity |® Exit |
Reference: * ¥ Generate Reference Automatically ocatioe | T j o
= S
Customer: ]1112 Baker, Mike j Find Add Createq negative value =
Invoice Date: [Nov 06,2013 =~ DueDate: |Dec06.2019  ~x|” $$ refunded ($237.00)
Customer and Shipping ] Purchases Retums (2) ]Totals ] Immediate Payment ]
Product Quantity Unit Price Taxes Line Total ‘epay? Location LOT Ref
3101011 - PERIMETER [1 3.4 L (JU) 30 £204.00 £0.00 (£612.00) [ St. Albert
> | FMCDISC - FMC Instant Discount (AC) 150.0 (£2.50) £0.00 £375.00 [ St Alhect
_ ( positive value =
= Net Refum $$ deducted from refund
Returns Subtotal (before tax): (£237.00) Add Blend Ror W

Import from LOT

The grower is credited the net value of the Perimeter Il returned LESS the value of the FMC Instant
Discount on the PrecisionPac of the original purchase.
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Reporting to FMC

Because all products involved in the FMC Instant Discount process are flagged with
FMC as the manufacturer, all transactions regarding those products will be included in
the Manufacturer Sales (FMC) data export.

- =

% Export Data E\@

Export to File | # Export to Excel Preview Datz %ﬂ Exit
Select the data you want to expaort/preview? ¥ Include Header Line
B Accounts Receivable a [ Criteria

R Invoice Summary _ ’—_l
R Invoice Taxes ST Dec 06. 2020 hd
ill And Hold Invoices End Date: Jan 06, 2021 -

Chemical Sales Summary (AB Env.) . - —
omp. Customer. Sales by Gty Location: |"N| Locations > s

Low Sales Margins

Manufacturer Sales (FMC)
05 Data (TKXS)
05 Data (USI) o

File > Exports > Data

The export data will include all sales and returns of the Instant Discount, PrecisionPac, and Perimeter |1

products.
% Manufacturer Sales (FMC) E\@
Q B
Simple lﬁd\tanced l

Retziler RetailCity RetailProv CuslD FarmMam| | Units UnitPrice TotalSales -
Dog River Deg River SK 30 Carter Fan 2.0000 S60.0000  1520.0000000
St. Albert St. Albert AB 20 -1.0000 275.0000  -275.0000000
Dog River Deg River SK 2 Abraham [ 1.0000 1000.0000  1000.0000000
Dog River Dog River SK 2 Abrsham £ 2.0000 275.0000  550.0000000
Dog River Dog River SK 50 Carter Far 1.0000 275.0000  275.0000000 v

<" B [ s P + nnnn P ——— 5

Select All To copy selected cells press Cirl + C.
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